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BI Fiori Launch Pad Overview ⤒ 
 
 

You can perform a fresh SAP BI 4.3 full install or upgrade your previous SAP BI 4.x 

system. In both cases, you need a new 4.3 license that can be downloaded from 

the SAP Support web site. 

 
 

Once installed and deployed, you can connect to the BI Launch Pad through its Login 

page, whose URL is by default http://<server>:<port>/BOE/BI 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

BI Launch Pad: Login Page 
 
 

After you have authenticated, the Home page presents some tiles that give you access 

to repository’s resources: 

 
 
 
 
 
 
 

• Folders: to navigate in the BI Platform repository folders.

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
https://support.sap.com/en/my-support/keys.html#section_1391186636
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• Categories: to navigate in the BI Platform repository categories. 
 
 
 
 
 
 

• Documents: to display your documents as a flat list. 
 
 
 
 
 
 

• BI Inbox: to access the documents and alerts you have received. 
 
 
 
 
 
 

• Instances: to give you an overview of all your schedules and publications. 
 
 
 
 
 
 

• Recycle Bin: to display and restore documents you have deleted.
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BI Launch Pad: Home Page 
 
 

Under these tiles, three sections with document tiles are displayed. These documents 

are the ones: 

 
 
 
 
 
 
 

• You have set as favorites (Favorites) 
 
 
 
 
 
 

• You have previously opened (Recent Documents)
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• That have been recently processed through schedules (Recently Run). 
 
 
 
 
 

Finally, the Applications section contains tiles you can click to start the corresponding 

application hosted in BI Launch Pad. These applications include Web Intelligence. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

BI Launch Pad: Applications Tiles 
 
 
 
 
 

To modify the BI Launch Pad settings, click the icon ( ) at the top left of 

the Home page, then Settings to open the Settings dialog box. 

 
 
 
 
 
 
 
 
 
 

• In the Application Preferences section, click the Web Intelligence tab to 

display the Web Intelligence preferences. In addition to the usual drill, Excel save 

or right-to-left orientation options, you can also define your measurement unit 

(centimeters or inches). This was previously defined at document level and you 

had to set it for every document.
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BI Launch Pad: Web Intelligence Preferences 
 
 
 
 
 
 
 
 
 
 

• In the Appearance section, you can also choose another Fiori theme for the 

user interface, for example a high contrast display for BI Launch Pad and Web 

Intelligence.
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Web Intelligence: High Contrast Display 
 
 

To open a Web Intelligence document: 
 
 
 
 
 
 
 

• If it is displayed on the Home page as a tile, click this tile to open it 

in Reading mode 

 
 
 
 
 

• If you access the document through the Folders, Categories or Documents tile, 

click the More button ( ) to open the contextual menu. This menu contains the 

different actions you can perform on this document, including View to open it 

in Reading mode or Modify to open it in Edit mode
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BI Launch Pad: Document Menu 
 
 

For more details about BI Launch Pad's new features, see SAP BusinessObjects BI 4.3: 

What's New. 

 
 

Web Intelligence: Reading Mode ⤒ 
 
 

The Web Intelligence Reading mode proposes a simplified interface in which users can 

easily view, refresh and export documents. It proposes some interactivity and analysis 

capabilities through input controls, elements linking, drill or track changes. In SAP BI 

4.3, this Reading mode interface is similar to the Web Intelligence Interactive Viewer 

FIORI-based interface released since SAP BI 4.2 SP4. 

 
 

Main Toolbar

https://blogs.sap.com/2020/06/30/sap-businessobjects-bi-4.3-whats-new/
https://blogs.sap.com/2020/06/30/sap-businessobjects-bi-4.3-whats-new/
https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
https://blogs.sap.com/2017/04/11/sap-bi-4.2-sp4-preview-of-whats-new-in-web-intelligence-and-semantic-layer/
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The toolbar contains sections with the following commands: 
 
 

File 
 
 
 
 
 
 
 

• : Opens the menu with the Save and Save As 
 
 
 
 
 
 

• : Undoes the last actions. 
 
 
 
 
 
 

• : Redoes the last undone actions. 
 
 
 
 
 
 

•  : Opens the Print dialog box to set parameters (report and page selection, 

page size, orientation, margins and scaling) and generate a PDF that can be 

printed out. 

 
 
 
 
 

•  : Opens the Export to dialog box to export the report’s or cube’s data into 

different file formats. The dialog box has been reorganized to better display all 

possible options (Request 215268) and to propose the Excel format by default 

(Request 140228).

https://influence.sap.com/sap/ino/#/idea/215268
https://influence.sap.com/sap/ino/#/idea/140228
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Web Intelligence: Export to Dialog Box 
 
 
 
 
 
 
 
 
 
 

•  : Opens the Send to users dialog box in which you can select the users or 

groups that are to receive this document in their BI Platform repository inbox.
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• : Opens the Online Help on the SAP web site. 
 
 
 
 
 
 

• : Displays the Web Intelligence version. 
 
 
 
 
 

Data 
 
 
 
 
 
 
 

•  : Refreshes the document’s queries that have been selected for refresh by the 

document’s designer. In the new interface, this button is more visible 

(Request 131476), especially when a data provider has been partially refreshed. 

In this case, a warning is sent and an orange dot ( ) is added to 

the Refresh button (Request 206429). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Web Intelligence Refresh: Partial Refresh Warning 
 
 

Analyze

https://influence.sap.com/sap/ino/#/idea/131476
https://influence.sap.com/sap/ino/#/idea/206429
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•  : Opens or closes the Filter Bar used to display and set filters values (see 

description below). Another icon is displayed ( ) if (a) filter(s) already 

applies/apply to the current report. 

 
 
 
 
 

• Drill checkbox: Enables/disables the drill mode. 
 
 
 
 
 
 

• Fold/Unfold checkbox: Enables/disables the fold / unfold. 
 
 
 
 
 
 

• Show Changes checkbox: If the “Track Data Changes” feature has been 

enabled, use this checkbox to highlight these changes. 

 
 
 
 
 

•  : Opens the Track Data Changes dialog box in which you can enable/disable 

the tracked changes, define the dataset reference and the reports to compare. It 

also displays the fonts and colors used to show the differences. 

 
 
 
 
 

•  : Switches to the "Auto Refresh" mode in which the document is refreshed 

regularly and automatically (see SAP BI 4.2 SP6). Before entering this mode, you 

need to define a refresh frequency and answer potential prompts if any. These 

values are kept for the next refresh actions, as long as you remain in this mode.

https://blogs.sap.com/2018/06/19/sap-bi-4.2-sp6-whats-new-in-web-intelligence-and-semantic-layer/
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Reading Mode: Auto-Refresh 
 
 
 
 
 
 

Filter Bar 
 
 

In Reading mode, the Filter Bar is the single place where you can see and, when 

possible, modify the filters and input controls that impact your document’s dataset. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Reading Mode: Filter Bar
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In detail, the Filter Bar contains the following items: 
 
 
 
 
 
 
 
 

• The Reset button ( ) to reset all input controls to their default values and 

remove the element linking filtering (Request 144999). 

 
 
 
 
 

• The prompts that have been answered during the document’s queries execution. 

Click Prompts ( ) to see these values. To modify them, refresh your document 

and provide new values for the prompts. 

 
 
 
 
 

• The document’s input controls ( ) that apply to the whole document, and the 

report input controls ( ) that apply only to the current report. Click an input 

control to modify its values using list, multi-list (checkboxes), slider, spinner… 

depending on the document’s designer choice. For list and multi-list, a search 

text field can be used to find only the values that match a search string.For a 

group of input controls, click the group and select the input controls to add. The 

order in which you select the input controls defines the filter path, i.e. the input 

controls' dependencies. For example, if you select Country before City, the 

selected countries filter your choice of cities.

https://influence.sap.com/sap/ino/#/idea/144999
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• Element linking through which a block is filtered by a value selected in a table. 

Click the element linking icon ( ) to display the value of this element linking and 

reset it, if needed. 

 
 
 
 

If the window is too small to display the full Filter Bar's content, then arrows are 

displayed on its edges allowing you to scroll. 

 
 
 
 
 
 
 
 
 
 
 

Reading Mode: Filter Bar Scrolling Arrows 
 
 
 
 
 
 

Report Selection and Vanishing Toolbar 
 
 

In Reading mode, you can move from one report to another by clicking the 

corresponding tabs displayed under the toolbars. 

 
 

To navigate in the report, you may use the Vanishing Toolbar at the bottom of the 

page. This toolbar appears when you move your cursor to the bottom of the page and 

disappears when you stay idle for a few seconds. This toolbar contains the following 

commands: 

 
 
 
 
 
 
 

• The controls to go to the first page, previous page, a specific page, next page or 

last page.
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• : Opens the Zoom slider to select the zoom ratio. 
 
 
 
 
 
 

• : Toggles between the Print layout and the Draft 
 
 
 
 
 
 

• : Fits the page’s width to the window’s width. 
 
 
 
 
 
 

• : Fits the page to the window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Reading Mode: Vanishing Toolbar 
 
 
 
 
 
 

Side Panel
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Unlike the previous releases, the side panel is located on the right. To open or close this 

side panel, click one of the buttons in the toolbar depending on the content you want to 

display: 

 
 
 
 
 
 
 

•  : The Navigation Map pane, to quickly navigate in the report based on its 

sections. 

 
 
 
 
 

•  : The Comments pane, containing the comment threads. Click an existing 

comment in the document to view its thread or right click a report element in the 

document to comment it. 

 
 
 
 
 

•  : The Document properties pane, to display the document's statistics and 

properties (Refresh on open, document style, …)
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Reading Mode: Navigation Map, Comments and Properties Side Panels 
 
 
 
 
 
 

Web Intelligence: Edit Mode ⤒ 
 
 

The main improvement in SAP Web Intelligence 4.3 is the Edit mode. It completes the 

FIORI convergence (Request 209030). This mode has been simplified to improve the 

productivity of report designers by allowing them to perform tasks faster.

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
https://influence.sap.com/sap/ino/#/idea/209030
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There are several ways to open the Edit mode: 
 
 
 
 
 
 
 

• By clicking the Web Intelligence tile on the BI Launch Pad Home page and 

creating a new document. 

 
 
 
 
 

• By selecting the Modify command ( ) on the document menu allowing you to 

edit this document. 

 
 
 
 
 

• In Reading mode, by clicking the Edit button to edit the current document. 
 
 
 
 
 
 
 

Main Toolbar 
 
 

The toolbar contains only general commands that apply to the overall document. These 

commands should be familiar and have been reorganized for a simpler and faster 

access (Request 107473).

https://influence.sap.com/sap/ino/#/idea/107473
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Edit Mode: Toolbar 
 
 

The toolbar contains sections with the following commands: 
 
 

File, that contains the same commands as in Reading mode 
 
 

Data 
 
 
 
 
 
 
 

• : Opens the Query Panel allowing you to edit the document’s queries. 
 
 
 
 
 
 

•  : Opens the Refresh menu described below. As in Reading mode, when a 

data provider has been partially refreshed, an orange dot is displayed on 

the Refresh button ( ) to provide you with a visual "document contains partial 

data". 

 
 
 
 
 

• Change Source: Opens the Change Source Wizard dialog box, to change 

universes, SAP BW or SAP HANA data providers. 

 
 
 
 
 

• Purge Data: Opens the Purge Data Providers dialog box, to remove datasets 

from queries.
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Insert 
 
 
 
 
 
 
 

•  : Opens the menu in which you can select tables types and forms to insert into 

your report. 

 
 
 
 
 

•  : Opens the menu in which you can select one of the default charts types to 

insert. For further charts types, open the Turn Into section in the Data side 

panel. 

 
 
 
 
 

• : Opens the menu in which you can select predefined cells to insert. 
 
 
 
 
 
 

• : Adds a section. 
 
 
 
 
 
 

• : Inserts a custom element, if you have registered one in the CMC. 
 
 
 
 
 

Analyze
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•  : Opens/closes the Filter Bar (see below). As in Reading mode, an icon is 

used to highlight that the dataset is filtered ( ). 

 
 
 
 
 

• : Opens/closes the Formula Bar (see below). 
 
 
 
 
 
 

• Drill, Fold/Unfold, Show Changes checkboxes: As in Reading mode, click 

these checkboxes to enable/disable drill, enable/disable fold/unfold or show 

document changes. 

 
 
 
 
 

• : Opens the Track Data Changes dialog box. 
 
 
 
 
 
 

• : Opens the Manage Formatting Rules dialog box. 
 
 
 
 
 

Display 
 
 
 
 
 
 
 

• : Opens the Zoom slider to select the zoom ratio.
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• : Toggles between the Print layout and the Draft 
 
 
 
 
 
 

• Structure checkbox: Use this checkbox to switch between Structure and Data 
 
 
 
 
 
 

• : Fits the page’s width to the window’s width. 
 
 
 
 
 
 

• : Fits the page to the window. 
 
 
 
 
 

Navigate contains the same controls as in the Vanishing Toolbar of the Reading mode 

to navigate in the report’s pages. 

 
 

Depending on your screen size, some commands are reachable by opening 

the More menu ( ). 

 
 

Filter Bar 
 
 
 
 
 

Like in Reading mode, you can use the Filter Bar to view and change filters values. 

In Edit mode, you can in addition manage input controls and group of input controls, 

through the Manage Input Controls button ( ).

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#VANISH
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Edit Mode: Filter Bar 
 
 

Click this button to open a menu with the following commands: 
 
 
 
 
 
 
 

• New Input Control: Opens the New Control dialog, in which you can provide 

the different parameters to create an input control (the impacted object, its scope 

document or report, the interface item used to modify it…)
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Edit Mode: New Control 
 
 
 
 
 
 
 
 
 
 

• New Group of Controls: Once you have selected the scope of the group to 

create (the whole document or the current report), the New Group dialog box 

opens. You can give the new group a name and click Add Control to select the 

input controls to add in this new group. If needed, you can click New Control to 

create an input control on the fly and add it.
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Edit Mode: New Group of Input Controls 
 
 
 
 
 
 
 
 
 
 

• Manage Filter Bar: Opens the Manage Filter Bar dialog box listing all input 

controls and groups. Select a group or input control and click the Edit icon ( ) to
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edit it or the Delete icon ( ) to delete it. 

To define the position of a group of input control on the Filter Bar, select it and 

use the arrow buttons ( and ) to move it up and down in the list. 

You can also create a group or an input control from this dialog box by clicking + 

Add. 

 
 
 
 
 

• Reset All: Resets all input controls to their default values and removes the 

element linking filtering. 

 
 
 
 

Another way to edit an input control’s properties is to click first the input control in 

the Filter Bar, then the Settings icon ( ) and finally Advanced Settings. This opens 

the Edit Control dialog box. 

 
 

Formula Bar 
 
 

In the Formula Bar, you can enter a value or a formula in a cell. This Formula 

Editor supports auto-completion: while you type a formula, a menu proposes the 

objects, functions or operators that match the letters you have typed 

(Requests 236699 and 241647). You may select the one to use by clicking it or by using 

the arrow keys and pressing [Enter].

https://influence.sap.com/sap/ino/#/idea/236699
https://influence.sap.com/sap/ino/#/idea/241647
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Edit Mode: Formula Bar 
 
 

The Formula Bar contains the following four buttons: 
 
 
 
 
 
 
 

• Display the Formula Editor: Opens the Formula Editor that can help you to 

type the formula. 

 
 
 
 
 

• Create a new variable using this formula: Opens the Formula Editor allowing 

you to create a variable from the formula in the Formula Bar. 

 
 
 
 
 

• Restore the initial formula: To cancel the formula you have entered and restore 

the previous one. 

 
 
 
 
 

• Validate the formula: To validate and save the current formula in the cell. 
 
 
 
 
 
 
 

Report Tab 
 
 

In the document, you access a report by clicking the corresponding tab below the Main 

Toolbar and Filter Bar.
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Click the drop-down menu ( ) beside the report name to open the menu containing 

commands to add a new report, duplicate, delete, rename or move the selected report. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edit Mode: Report Menu 
 
 

The last command in the menu (Copy Link of the Report) copies the Opendoc URL to 

this report into the clipboard. You may copy and share this URL that can be used to 

directly open this report. 

 
 

Main Side Panel 
 
 

The Edit mode proposes two side panels and as in Reading mode, they are located on 

the right. By default, only the main side panel opens. It contains two stacked panels:
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• Report Structure: This panel displays the report structure with the different 

blocks it contains. 

 
 
 
 
 

• My Objects: This panel displays the document dictionary with all objects 

retrieved by the queries and also the enrichments added by the document 

designer. 

 
 
 
 

Like in Reading mode, the buttons on the toolbar can be used to display the Navigation 

Map, Comments and Document properties panels in the main side panel. In Edit 

mode, they replace the Report Structure and My Objects panels when 

selected. Document properties panel allows you to modify document’s options and 

properties in Edit mode.
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Edit Mode: Main Side Panel 
 
 
 
 
 
 

Main Side Panel: Report Structure 
 
 

As in previous releases, the Report Structure displays a tree of all items in the current
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report: header, footer, charts, cells, tables, … 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edit Mode: Report Structure Side Panel 
 
 

It can be useful to understand how a report is organized and access a specific block 

rather than looking for it in the document: if you click the More icon ( ) beside an item, 

the Format and Data commands open the Format and Data panels described below. 

 
 

Main Side Panel: My Objects
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The My Objects panel lists the document’s dictionary. In this panel, you manage the 

objects retrieved from the document’s queries, the enrichment you defined for these 

objects as well as the variables and references you create. For example, to add a new 

variable, click Add Variable, to opens the Formula Editor and create your variable. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edit Mode: My Objects Panel 
 
 
 
 
 

You can display these objects in alphabetical order, by folders or by queries. The 

corresponding options are Alphabetical View, Folders View or Queries View and are 

available in the View Mode menu ( ).
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Click the More options icon ( ) beside an object to open its contextual menu with the 

usual actions you can perform: 

 
 
 
 
 
 
 
 
 
 

• Enriching a dimension by making it a geo or time dimension 
 
 
 
 
 
 

• Merging / unmerging objects 
 
 
 
 
 
 

• Managing groups 
 
 
 
 
 
 

• Editing object properties 
 
 
 
 
 
 

• Setting the measure type to Number or Decimal 
 
 
 
 
 
 

• Defining a custom sort for the object



34 
 

 
 
 
 
 
 

• … 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edit Mode: My Objects Contextual Menu 
 
 

This panel works in a similar way than in previous releases. There are, however, a few 

usability enhancements: 

 
 
 
 
 
 
 

• You can delete several variables at the same time (Request 208832).

https://influence.sap.com/sap/ino/#/idea/208832
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• The focus remains on the current variable when you edit it (Request 208418). 
 
 
 
 
 
 

• In Queries View, you can directly edit a query and open it in the Query Panel by 

clicking the Edit Query icon ( ). 

 
 
 
 
 
 
 

Build Side Panel 
 
 
 
 
 

The Edit mode introduces a second side panel that can be opened or closed through a 

fourth button ( ) located in the toolbar. This second side panel replaces the modal 

dialog boxes (Assign, Turn To, Format, Breaks, Sort, …) available in previous 

releases. It contains all the properties that were previously exposed in the modal dialog 

boxes. Depending on their category, these properties are displayed in one of these two 

panels: 

 
 
 
 
 
 
 
 
 
 

• Data, defines the data structure of the item you have selected

https://influence.sap.com/sap/ino/#/idea/208418
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• Format, defines the format of the item you have selected 
 
 
 
 
 

You can switch from one panel to another by clicking their respective header. 
 
 

They are contextual panels and the displayed properties depend on your selection. 

When you select an element, it automatically displays the relevant properties. 

 
 

The properties you set in the Data panel are immediately applied to the selected item. 

You can decide to automatically apply the properties you picked in the Format panel by 

selecting the Instant Apply checkbox at the bottom of the panel. As these format 

changes imply regular requests to the server for each modification, you may prefer to 

unselect this checkbox and rather click Apply in one request to the server. 

 
 
 
 
 
 
 
 
 
 
 
 

Edit Mode: Format Panel Apply Options 
 
 

This new side panel is one of the main enhancements of the document authoring 

workflows. As described in the next two sections, setting a format or organizing a block 

feed is much easier through this side panel than via the previous dialog boxes 

(Requests 109434 and 107959). 

 
 

Build Side Panel: Data 
 
 

The Data panel is available when you select a chart or a table and is used to define the 

data and structure of this selected table or chart block. The corresponding properties of 

the Data panel are organized in tabs, and only tabs relevant to your selection are

https://influence.sap.com/sap/ino/#/idea/109434
https://influence.sap.com/sap/ino/#/idea/107959
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displayed. These tabs are: 
 
 
 
 
 
 
 

•  : The Feeding tab contains the Turn into command used to select the table or 

chart type for this block. If you have registered custom elements in the CMC, 

they appear in the last menu of the Turn Into command. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edit Mode: Selecting Custom Element (Courtesy from Need4Viz) 
 
 
 
 
 
 
 

The Data Assignment section defines the objects used in the selected table or 

the chart. You may easily add objects to this block by drag-and-dropping them 

from the My Objects panel. Drag and drop can also be used to more easily 

change the objects’ order in the block.
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Edit Mode: Adding Objects to a Table Through Drag and Drop 
 
 
 
 
 
 
 

Another way to add objects is to click the More icon ( ), select 

the Formula and picks them from the Formula Editor or enter a formula to feed 

the block.



39 
 

 
 
 
 
 
 
 
 
 
 
•  : To manage the Filters and Element Links for the selected block. If a filter 

has been defined, then a dot is displayed on the tab. This tab provides an 

overview of all filters that apply to this block by listing also the input controls. 

 
 
 
 
 

•  : To manage the Sort that applies to the selected block. If sorts have been 

defined, the number of defined sorts is displayed on the tab. 

 
 
 
 
 

•  : To manage the Ranking that applies to the selected block. If a ranking is 

defined, a dot is displayed on the tab. 

 
 
 
 
 

• : To manage the Breaks options of the selected table.
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Edit Mode: Data Sub-Tabs for a Chart 
 
 
 
 
 
 

Build Side Panel: Format 
 
 

The Format panel contains all formatting properties for the selected item: report, cell, 

table, table cell, chart… To select a specific area of a chart (axis, title, legend, …), you 

can either: 

 
 
 
 
 
 
 

• Click this area in the chart itself.



41 
 

 
 
 
 
 
 

• Or select the chart and then the desired chart area in the menu located beside 

the chart’s name in the Format 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edit Mode: Chart Area Selection 
 
 

The properties you can set depend on your selection, since some may not be relevant 

to your selection. These properties are organized by categories in the Format panel’s 

sub-tabs. 

 
 
 
 
 
 
 

•  : Contains Display settings. For tables, it includes the properties that define 

what must be displayed or hidden: header, footer, object name, hide when 

empty, duplicate rows aggregation… For charts, it also includes the components 

to be displayed or not: title, data label, legend, …
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•  : Contains Appearance settings, like background color, borders' definition, 

spacing, padding… 

 
 
 
 
 

• : Contains Text settings, like its police, font, color, alignment, … 
 
 
 
 
 
 

• : Contains Styling settings for charts, like palette, markers size… 
 
 
 
 
 
 

•  : Contains Layout settings. For pages, it includes print layout, margins and 

scaling properties. For blocks, it includes relative positioning regarding other 

blocks, size and page break options…
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Edit Mode: Format Sub-Tabs for Charts 
 
 

At the top of the panel, beside the name of the selected block area (that can be 

changed as in the Data side panel), you may open the Format Painter menu ( ). It 

contains the Copy Format and Reset Format commands to respectively copy or reset 

the format of the current block.
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Edit Mode: Format Menu 
 
 
 
 
 
 

Query Panels 
 
 

When you create a document or add a query to an existing document, you are asked to 

select a data source type and then the data source itself. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Query Panel: Data Source Type Selection 
 
 

The Query Panel opens, and you can select objects to create a query and retrieve the
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corresponding dataset. This Query Panel depends on the data source type. In SAP BI 

4.3, these Query Panels are similar to the ones available in SAP BI 4.2, except for the 

FIORI skin, and propose the same features. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Query Panel: Universe Data Source
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Query Panel: Excel Data Source 
 
 

To run the query and close the query panel, click Run. If your document contains 

several queries, you can open a menu from this button and select the query to run. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Query Panel: Selecting Query to Run
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Refresh and Purge Queries 
 
 
 
 
 

The Refresh menu ( ) of the toolbar's Data section contains the following commands: 
 
 
 
 
 
 
 
 
 
 

• Refresh to refresh all authorized queries. 
 
 
 
 
 
 

• Refresh Data For to open a dialog box that provides some statistics about the 

queries’ last refresh. You can explicitly select the data sources to refresh during 

the next document refresh.
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Refresh Data Providers Dialog Box 
 
 

The toolbar’s Data section also contains the Purge Data command that opens 

the Purge Data Providers dialog box. The content of this dialog box is the same as in 

the Refresh Data Providers dialog box. However here, you can explicitly purge data 

from the data providers of your choice by selecting the checkbox in front of the data 

providers and clicking Purge (Request 143679).

https://influence.sap.com/sap/ino/#/idea/143679
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Purge Data Providers Dialog Box 
 
 
 
 
 
 

Web Intelligence: Rich Client ⤒ 
 
 

SAP BI 4.3 also offers Web Intelligence Rich Client for desktop usage. It is not a Java 

application any longer bur rather reuses the same interface as the SAP BI 4.3 web 

version in BI Launch Pad. 

 
 

As all desktop tools in SAP BI 4.3 (Information Design Tool, Universe Design Tool…), it 

is released in 64-bit (Request 107828). 

 
 

Login 
 
 

You can start Web Intelligence Rich Client from the Start menu or by double-clicking a 

locally-saved Web Intelligence document. You land on the login page the process of 

which has been simplified (Request 127659). You are required to enter the system 

name, your credentials and the authentication mode. With the toggle button, you can 

choose to work in Online or Offline mode (used to work disconnected after you have 

retrieved resources locally on your desktop). 

 
 

The Standalone and ZABO modes (allowing you to download and install Web 

Intelligence Rich Client from BI Launch Pad) are not yet released.

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
https://influence.sap.com/sap/ino/#/idea/107828
https://influence.sap.com/sap/ino/#/idea/127659
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Web Intelligence Rich Client : Login Page 
 
 

If your login parameters are valid, Web Intelligence Rich Client displays 

the Welcome page. 

 
 

Welcome Page 
 
 

The new Web Intelligence Welcome page design is similar to the Home Page of BI 

Launch Pad.
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Web Intelligence Rich Client: Home Page 
 
 

Three tiles are displayed at the top of this page. They offer actions that follow the 

workflows of your documents: 

 
 
 
 
 
 
 

• Import: To select a document in the BI Platform repository and explicitly import it 

toa local folder so that you can edit it. 

 
 
 
 
 

• Open: To open a document you have previously imported on your local file 

system. 

 
 
 
 
 

• New: To create a local document.
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The Welcome page also displays two other sections: 
 
 
 
 
 
 
 

• The Recent Local Documents section displays tiles for the local documents you 

have previously opened. These tiles contain a thumbnail of the document, a 

snapshot taken the last time the document was saved, as well as its last save 

date. Click a tile to open the corresponding document. 

 
 
 
 
 

• The Open Documents section displays tiles for the documents that are open in 

this session. These tiles show a thumbnail of the active report of the document. 

You can also click this thumbnail to quickly switch to this document or click the 

cross icon in the tile’s header to close it.
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Web Intelligence Rich Client: Recent and Open Documents Tiles in Welcome Page 
 
 

The drop-down menu at the top of the Welcome page header, contains the following 

commands: 

 
 
 
 
 
 
 

• Settings: to set Web Intelligence Rich Client parameters like the local 

documents’ default folder, the drill options, the locales or the measurement unit. 

 
 
 
 
 

• Help and About: To open the usual Online Help and About dialog box. 
 
 
 
 
 
 

• Log Out: to logout and return to the Login page.
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• Exit: to exit the tool. When exiting, all local Web Intelligence processes are 

terminated. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Web Intelligence Rich Client: User Menu
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Web Intelligence Rich Client: Settings Dialog Box 
 
 
 
 
 
 

Creating a Document 
 
 

To create a local document, click the New tile in the Welcome page. The interface and 

workflows to create a document are the same as in BI launch Pad:
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• Select the data source type, then the data source itself. (The data source you 

can select must be stored in the repository; local data providers are not yet 

supported.) 

 
 
 
 
 

• Create and run your query. 
 
 
 
 
 
 

• Add charts, tables, formatting… to your report and add new reports and queries 
 
 
 
 
 

Basically, you can take advantage of the same Edit and Read modes as in the web 

version, except for some features that are not yet supported or not yet available: 

 
 
 
 
 
 
 

• You can view comments but cannot modify comments on local documents. 
 
 
 
 
 
 

• You cannot send a document to BI Platform users. 
 
 
 
 
 

Once you have finalized your document, you can:
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• Save it locally by selecting the File > Save You can reopen it later by selecting 

the Open tile in the Welcome page. 

 
 
 
 
 

• Publish it in the BI Platform repository by selecting the File > Publish to 

Enterprise command, and then select the destination folder in the Publish 

Document dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Web Intelligence Rich Client: Publish Document Dialog Box
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Importing a Document from the Repository 
 
 

If you have already some documents in the BI Platform repository, you can work on 

them in Web Intelligence Rich Client. Start Web Intelligence and connect to the BI 

Platform repository. In the Welcome page, click the Import tile to open the Import and 

Open dialog box and select the document to import and open. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Web Intelligence Rich Client: Import and Open Dialog Box 
 
 

The selected document is copied to your file system, and this copy is opened for you to 

work on it using the same interface as in BI Launch Pad.
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Once you have finalized your changes, you can save it in the BI Platform repository 

again by selecting the File > Publish to Enterprise command first, and the destination 

folder in the Publish Document dialog box as a second step. 

 
 

You may prefer to save it locally for further changes before publishing it. In this case, 

select the File > Save command or select the File > Make Copy one to create another 

local copy. 

 
 

In both cases, depending on your security rights, you may save it: 
 
 
 
 
 
 
 

• With document access to all users, so that all repository users that have provided 

their credentials can open it. 

 
 
 
 
 

• While removing the document's security, so that users do not need to 

authenticate anymore. 

 
 
 
 
 

• While keeping it secured for you only. 
 
 
 
 
 

Later on, if you restart Web Intelligence Rich Client in Online or Offline mode, you can 

reopen this local copy by clicking the Open tile in the Welcome page. 

 
 

Web Intelligence: Document as a Data Source ⤒

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
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The support of Web Intelligence document as a data source for another document is a 

new capability offered in SAP BI 4.3 (Requests 107970 and 109142). The source 

document can be considered as a virtual universe and a database; and their metadata 

and data can be shared and leveraged by other documents. 

 
 

This feature covers several use-cases: 
 
 
 
 
 
 
 

• A document that queries a large dataset can be refreshed during quiet periods 

through a schedule and then be used as a data source for other documents. 

These documents do not query the initial data sources, but the dataset saved in 

the source document. This prevents initial data sources from being too solicited 

and improves the refresh time. 

 
 
 
 
 

• A power report designer may prepare metadata (merged dimensions, geo-

dimensions, time dimensions, variables) and share it through a source document. 

 
 
 
 
 

• Likewise, a document that queries multiple heterogeneous data sources can be 

exposed as one single metadata provider and hide the complexity of the data 

sources it queries. 

 
 
 
 
 
 
 

Creating a Query

https://influence.sap.com/sap/ino/#/idea/107970
https://influence.sap.com/sap/ino/#/idea/109142
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When you create a document or add a query to an existing document, you can 

select Web Intelligence document in the list of possible data sources. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Web Intelligence: Adding a New Query 
 
 

You are then asked to select a document in your Personal folders or in 

the Public folders of the BI Platform repository.
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Web Intelligence: Document Selection 
 
 

Once you have selected the source document, the Query Panel opens and displays the 

document’s objects: its dimensions, attributes, measures, hierarchies or variables... You 

can define a query by drag-and-dropping objects in the Results Objects section. You 

can also add filters in the Query Filters section to narrow down the dataset to retrieve 

from the source document. 

 
 

This Query Panel is very similar to the one used for universes, although it does not yet 

support features like combined queries, advanced filters or query stripping.
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Query Panel: Web Intelligence Document Data Source 
 
 

If the source document contains hierarchies, you may use the Member Selector to 

select the members to query. This Member Selector supports the same operators as 

for SAP BW data sources: Children, Descendants Until and Descendants Unit Named 

Level, but not Ancestors nor Parents. 

 
 

Refreshing Data 
 
 

The refresh retrieves the dataset from the source document. If your query contains 

filters or member selections, they are applied when it is sent to the source document. 

 
 

After the refresh, the objects that your query consists of appear in the My 

Objects panel. You can use them to feed the tables and charts in your report like you 

would for any data source. If you have enriched the source document with merged 

dimensions and/or geographical or time dimensions, they are retrieved as well and can 

be reused in the new document.
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During this refresh, the source document is not refreshed. This is the reason why a 

source a document defined as being refreshed on open or based on an SAP HANA 

Online data source, cannot be used as a data source. The source document must be 

explicitly refreshed, either manually or through a schedule. If the Smart View option has 

been selected in the CMC, the data is retrieved from the source document’s last 

scheduled instance. 

 
 

The aggregation of variable defined as measure is delegated to the source document. If 

you change the aggregation scope, the measure returns #TOREFRESH. Refresh the 

document to send the query against the source document so it returns the new 

aggregated value for the measure. 

 
 

View-Time Security Filtering 
 
 

The date of the dataset retrieved from the source document corresponds to the source 

document’s last refresh time. At refresh time, it is secured with the security profiles that 

apply to the user who is running the query. As the source document is not refreshed, it 

might be an issue if this source document dataset is shared with other users who do not 

have the same security profiles. 

 
 

If the source document queries a universe created with Information Design Tool and 

secured with a Business Security Profile, you can enable the Apply security filtering 

at view time option (see SAP BI 4.2 SP6) to filter the dataset when a document based 

on this source document is opened. 

 
 

If you set this option for the consuming document, the Business Security Profiles that 

apply to the user are enforced on the fly when the document is opened and without 

refreshing the source document, nor the document created on it: 

 
 
 
 
 
 
 

• Display Data Business Security Profiles prevents a denied object and its data to 

be displayed.

https://blogs.sap.com/2018/06/19/sap-bi-4.2-sp6-whats-new-in-web-intelligence-and-semantic-layer/
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• Only rows that match the filters conditions defined in the Filters Business 

Security Profiles are displayed. 

 
 
 
 

If you set this option for the source document, the filtering is applied when data is 

retrieved from this source document: 

 
 
 
 
 
 
 

• Display Data Business Security Profiles prevents a denied object and its data 

from being retrieved. 

 
 
 
 
 

• Only rows that match the filters conditions defined in the Filters Business 

Security Profiles are retrieved. 

 
 
 
 

You can also set this option for both documents. 
 
 

As this security relies on universe’s Business Security Profile, it applies only to source 

document queries based on universe created in Information Design Tool. 

 
 

Document Dependencies 
 
 

In the BI Platform repository, a link is created between the source document and a 

document that uses it as a source. Hence, dependencies between these documents are 

properly displayed in Life Cycle Management, Promotion Wizard or in the CMC if you
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use Tools > Check Relationships. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CMC: Source Document Relationship 
 
 
 
 
 
 

Web Intelligence: Geo Map ⤒ 
 
 

To provide more accurate geo dimensions, the Here geographical database used by 

Web Intelligence has been updated with its 2019 version: 

 
 
 
 
 
 
 

• Borders and regions take geographical changes into consideration, e.g., new 

French regions are available (Request 144513). 

 
 
 
 
 

• Regions, sub-regions and cities have been added in some countries for better 

coverage.

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
https://influence.sap.com/sap/ino/#/idea/144513
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• New cities have been added, some have been removed, considering the 

100,000 inhabitants limit, except for the United States of America. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Geo-Map: New French Regions 
 
 

If you have created geo charts in SAP BI 4.2 with a mapping by name, you need to 

remap these names when editing these documents in SAP BI 4.3 due to ID changes in 

the geographical database. 

 
 

Web Intelligence: Formula Language Functions and 

Formula Editor ⤒ 
 
 

In the Data Provider category, DataProviderType has been updated to return the correct

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
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data provider type. The possible values are: "Universe", "Text", "Excel", "Web Services", 

"SAP BW", "SAP HANA", "Free-Hand SQL" and "Web Intelligence" for the new Web 

Intelligence document data source. Besides NumberOfRows, NumberOfColumns has 

been added to return the number of objects of a data provider. 

 
 
 
 
 
 
 

• string DataProviderType ( Data provider dp ) 
 
 
 
 
 
 

• int NumberOfColumns ( Data provider dp ) 
 
 
 
 
 

In 

the Document category, DocumentPath, DocumentParentFolder and DocumentParentF 

older have been added to respectively return the document’s path (Request 108755), 

the name of its parent folder (Request 206442) and the document description 

(Request 144988). QuerySummary has also been updated to return the correct data 

provider type (cf. DataProviderType). 

 
 
 
 
 
 
 

• string DocumentPath () 
 
 
 
 
 
 

• string DocumentParentFolder ()

https://influence.sap.com/sap/ino/#/idea/108755
https://influence.sap.com/sap/ino/#/idea/206442
https://influence.sap.com/sap/ino/#/idea/144988
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• string DocumentDescription () 
 
 
 
 
 
 

• string QuerySummary () 
 
 
 
 
 

In the String category, Trim, LeftTrim and RightTrim have been extended to allow you to 

define the character to remove from the string (Request 217310). By default, this 

character is the space character. 

 
 
 
 
 
 
 

• string Trim ( string str [; string ch] ) 
 
 
 
 
 
 

• string LeftTrim ( string str [; string ch] ) 
 
 
 
 
 
 

• string RightTrim ( string str [; string ch] ) 
 
 
 
 
 

To create more readable and maintainable formulas, you can use the classic comments 

usually supported by most programming languages (Request 111272) in the formula 

language:

https://influence.sap.com/sap/ino/#/idea/217310
https://influence.sap.com/sap/ino/#/idea/111272
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• To comment the end of a line, you may use // 
 
 
 
 
 
 

• To comment a block in the formula, you may use /* */ 
 
 
 
 
 

When you open the Formula Editor, all category folders are closed by default 

(Request 202146). To find a function more easily, the All category (that contains all 

functions) is displayed at the top of the categories' list. 

 
 

As in the Formula Bar, the Formula Editor supports auto-completion. When you type a 

formula, a menu displays the objects, functions or operators that match the letters you 

typed (Request 241647). Select the one to use by clicking it or using the arrows keys 

and pressing [Enter].

https://influence.sap.com/sap/ino/#/idea/202146
https://influence.sap.com/sap/ino/#/idea/241647
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Auto-Completion in the Formula Editor
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Web Intelligence: Security Rights ⤒ 
 
 

To adapt the new interface and deployment modes, the Web Intelligence security rights 

have been updated: 

 
 
 
 
 
 
 

• Names and categories have been simplified and aligned (Request 214981) 
 
 
 
 
 
 

• Two new rights are introduced to secure the use of Free-Hand SQL 
 
 
 
 

(Request 219070                  Query: Edit Free Hand SQL script and Query: View 

Free Hand SQL script 

 
 
 
 

The following table lists Web Intelligence application 
security rights, with their equivalent in SAP BI 4.2. 

Previous SAP BI 4.2 Name 
 
 

SAP BI 4.3 Security Right 
 

Data: Enable data tracking 
 
 

Data: Enable formatting of changed data 
 
 

General: Enable Desktop client access 
 
 

Desktop: Publish to Enterprise 
 
 

Desktop: Print documents 

Data - Enable data tracking 
 
 

Data - Enable formatting of changed data 
 
 

Desktop interface - Enable Web Intelligence 

Deskto 
 
 

Desktop interface - Export documents 
 
 

Desktop interface - Print documents

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
https://influence.sap.com/sap/ino/#/idea/214981
https://influence.sap.com/sap/ino/#/idea/219070
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Desktop: Remove documents security 

 
 

Desktop: Give access to everyone 
 
 

Documents: Disable automatic refresh on open 
 
 

Documents: Enable autosave 
 
 

Documents: Enable creation 
 
 

Documents: Publish and manage content as web service 
 
 

General: Edit Web Intelligence preferences 
 
 

General: Enable Web client access 
 

Query: Edit script generated from universe 

Query: Edit Free Hand SQL 

Query: View script generated from universe 

Query: View Free Hand SQL 

Reporting: Create and edit breaks 

Reporting: Create and edit conditional formatting rules 
 

Reporting: Create and edit input controls and group 
 

Reporting: Create and edit predefined calculations 

Reporting: Create and edit filters and consume input 

controls 

Reporting: Create and edit sorts and rankings 

Reporting: Create and edit formulas, variables, groups and 

references 

Reporting: Enable document change 

Reporting: Merge objects 

Reporting: Insert and remove reports, tables, charts, and 

cells 

Desktop interface - Remove document security 
 
 

Desktop interface - Save document for all users 
 
 

Documents - Disable automatic refresh on open 
 
 

Documents - Enable autosave 
 
 

Documents - Enable creation 
 

Documents - enable publish and manage content as 

service 
 

General - Edit ‘My Preferences’ 
 
 

Interfaces - Enable web viewing interface 
 
 

Query script - Enable editing (SQL , MDX, ...) 
 
 

Query script - Enable viewing (SQL , MDX, ...) 
 

Reporting - Create and edit breaks 

Reporting - Create and edit conditional formatting 

r 
 

Reporting - Create and edit input controls 
 

Reporting - Create and edit predefined calculations 

Reporting - Create and edit report filters and consum 

input controls 

Reporting - Create and edit sorts 
 

Reporting - Create formulas and variables 
 

Reporting - Enable formatting 

Reporting - Enable merged dimensions 

Reporting - Insert and remove reports, tables, charts 

cells 
 
 

In the CMC, the following rights are prefixed with the “Obsolete_” tag since they are 

either useless in SAP BI 4.3 or their security intent is replaced by customization when it
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is supported: 
 
 
 
 
 
 
 

• Disable Export to BI On Demand for this user 
 
 
 
 
 
 

• Disable Import from BI On Demand for this user 
 
 
 
 
 
 

• General - Enable right-click menus 
 
 
 
 
 
 

• Interfaces - Enable Rich Internet Application 
 
 
 
 
 
 

• Left pane - Enable document structure and filters 
 
 
 
 
 
 

• Left pane - Enable document summary 
 
 
 
 
 
 

• Desktop interface - Save documents locally



75 
 

 
 
 
 
 
 

• Desktop interface - Import documents 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CMC: Web Intelligence Application Security Rights 
 
 

The following rights are still exposed in the CMC but will be leveraged once the 

corresponding features are supported: 

 
 
 
 
 
 
 

• Desktop: Send by e-mail 
 
 
 
 
 
 

• Desktop: Enable local data providers
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• Desktop: Install from BI Launch Pad 
 
 
 
 
 
 

• Shared: Publish shared elements 
 
 
 
 
 
 

• Shared: Insert shared elements 
 
 
 
 

The following table lists Web Intelligence document 
security rights, with their equivalent in SAP BI 4.2. 

 
 

SAP BI 4.3 Security Right 

Edit Query 

Export the cube’s data 

Export the report’s data 

Import document locally 

Refresh List of Values 

Refresh the report’s data 

Use Lists of Values 

View SQL 

 
 

Previous SAP BI 4.2 Name 
 
 
 

Edit Query 

Save as CSV 

Export the report’s data 

N/A 

Refresh List of Values 

Refresh the report’s data 

Use Lists of Values 

View SQL 
 
 

The Save as Excel or Text and Save as PDF security rights have been removed since 

exporting or scheduling report’s data into PDF, Excel, HTML archive, Text or CSV 

archive is now simply covered by the Export the report’s data right. 

 
 

Two new rights have been introduced:
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• Export the cube’s data: This right allows the user to export a document’s cube 

data or to schedule it into a CSV file. (Request 134236) 

 
 
 
 
 

• Import document locally:This new right replaces the previous application Desktop 

interface - Save documents locally and Desktop interface - Import documents 

security rights and is used to allow the document to be saved locally so that it 

can be opened in Web Intelligence Rich Client. 

 
 
 
 

The Publish shared elements right is still exposed in the CMC but will be leveraged only 

when the corresponding feature is supported. 

 
 

Web Intelligence: Publishing and Scheduling ⤒ 
 
 

When the new BI Launch Pad was released in SAP BI 4.2 SP4, it was possible to 

schedule documents but not to distribute them through publications. In SAP BI 4.3, this 

missing capability has been implemented in BI Launch Pad and offers the same options 

as in SAP BI 4.2. 

 
 
 
 

To create a publication, go to a folder, click the Create/upload objects button ( ) at 

the top of the folder’s page and select Publication in the menu.

https://influence.sap.com/sap/ino/#/idea/134236
https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
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BI Launch Pad: Publication in the Create Menu 
 
 

In the New Publication page, enter the publication parameters. These parameters are 

organized by sections, displayed in two tabs. Depending on the document type, some 

parameters appear only after the source documents have been added to the 

publication.
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BI Launch Pad: New Publication 
 
 

To navigate into the possible parameters more easily, you may click the following tabs, 

and select the section in the corresponding menus: 

 
 
 
 
 
 
 

• General. This tab contains the generic publication parameters: publication 

details, source documents, destination, recurrence, enterprise and dynamics 

recipients, events, … 

 
 
 
 
 

• Report Features. This tab and its sections appear if your publication contains a 

Web Intelligence or Crystal Reports document. It contains publication properties 

that are specific to this document type. For Web Intelligence, this covers the 

publication formats, personalization, prompts and delivery rules. 

 
 
 
 
 

• Summary: This tab displays the publication’s most common parameters.
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BI Launch Pad: Publication Menus 
 
 

When the publication is defined, click Save or Save and Close. 
 
 

In SAP BI 4.3, you can still schedule a document. To provide the same look & feel as 

in New Publication page, the Schedule page has been modified.
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BI Launch Pad: New Schedule 
 
 

When defining a schedule, you can move to specific sections through two tabs and the 

corresponding menus. 

 
 
 
 
 
 
 

• The General tab contains the generic sections that define a schedule, like the 

schedule's destinations and recurrence, its attached events, ... 

 
 
 
 
 

• The Report Features tab contains the sections specific to a Web Intelligence 

document. Formats, Prompts and Delivery Rules are available, but Caching 

properties are not yet implemented.
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BI Launch Pad: Schedule Menus 
 
 

Both schedule and publication take advantage of the new options introduced in SAP BI 

4.3: 

 
 
 
 
 
 
 

• When you define the publication or schedule frequency in 

the Recurrence section, you can select business days and hours for the 

schedule to run. 

 
 
 
 
 

• Another new option, Allow Retries, can be used to define if a failed schedule 

must be re-run and if so, how many times and when.



83 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

BI Launch Pad: Recurrence Options 
 
 
 
 
 
 
 
 
 
 

• In the BI Launch Pad Home page, click the Instances tile to display an overview 

of all schedules and publications run by you and their status. At the top of the 

page, you can find controls to filter this list by date, status, scheduled object type 

or just by name.
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BI Launch Pad: Schedule Instances Page 
 
 
 
 
 
 

Web Intelligence: OpenDocument URL ⤒ 
 
 

The Copy Link of the Report/Table/Chart/Cell commands previously described allow 

you to directly generate an Opendoc URL to access the corresponding item. You can 

also get the link to access a document by opening the document’s contextual menu in 

BI Launch Pad and selecting the Details command. The Opendoc URL you can share 

is provided in the Document Link field.

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
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BI Launch Pad: Document Details Dialog Box 
 
 

With the Web Intelligence user interface simplification, the sViewer option is no longer 

used by the Opendoc URL and is skipped when it is processed. Some options like 

instance are not yet supported in SAP BI 4.3 and will be supported in future Support 

Packages. 

 
 

To allow your user to directly access a folder, you can select the Details command in a 

folder’s contextual menu, and share the URL provided in the Folder Link.
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BI Launch Pad: Folder Details Dialog Box 
 
 
 
 
 
 

Web Intelligence: REST Web Services ⤒ 
 
 

In the Web Intelligence REST Web Services, some new APIs have been added: 
 
 
 
 
 
 
 

• To get, create, edit and delete referenced cells in a document 
 
 
 
 
 
 

• To get, create, edit and delete table’s calculations 

(Average, Count, Max, Min, Percent or Sum)

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
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• To get the details of a publication 
 
 
 
 
 

Some existing APIs offer additional options and can be used to: 
 
 
 
 
 
 
 

• Purge a document 
 
 
 
 
 
 

• Set a table cell as a section 
 
 
 
 
 
 

• Change the position of a report element in the layout (front, back…) 
 
 
 
 
 
 

• Delete all breaks of a table 
 
 
 
 
 
 

• Update or delete all breaks on a table axis 
 
 
 
 
 
 

• Get, edit or delete all custom formatting of a report element
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• Get the details of a hierarchy member 
 
 
 
 
 
 

• Re-order input controls 
 
 
 
 
 
 

• Create a custom format for number or datetime 
 
 
 
 
 
 

• Get the marker palettes, the gradient orientations and the locales supported by 

the BI Platform server 

 
 
 
 
 
 
 

Web Intelligence: Performance Enhancements ⤒ 
 
 

To improve the performance of Web Intelligence, several enhancements have been 

implemented: 

 
 
 
 
 
 
 

• The most visible one is the progressive disclosure, aka lazy loading: to avoid 

blocking the user while the document is fully displayed, the document skeleton is 

computed and displayed first, followed by the charts in the background. The gain 

is particularly significant on a document that contains many charts.

https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
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• The Web Intelligence REST Web Services calls used by the new Web 

Intelligence interface have been optimized 

 
 
 
 
 

•     Documents with the Refresh on open option are automatically purged when 

saved in order to reduce the document opening time (Request 110058). 

 
 
 
 
 

• A Web Intelligence document stores details related to the universes it queries. If 

one of these universes has been modified, the updated details are retrieved from 

this universe when the document is opened. A warning message is displayed to 

recommend that you save the document, to avoid the same update next time it is 

opened. 

 
 
 
 
 
 
 

Information Design Tool: 64-Bit ⤒ 
 

Like other client tools in SAP BI 4.3 (Web Intelligence Rich Client and Universe Design 

Tool), Information Design Tool and Connection Server drivers are released in 64-bit 

only (Request 210604). 

https://influence.sap.com/sap/ino/#/idea/110058
https://community.sap.com/t5/technology-blogs-by-sap/sap-bi-4-3-what-s-new-in-web-intelligence-and-semantic-layer/ba-p/13431074#TOC
https://influence.sap.com/sap/ino/#/idea/210604
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